Reference

TDS6000 Series
Digital Storage Oscilloscopes

CSA7000 Series
Communications Signal Analyzers

TDS7000 Series
Digital Phosphor Oscilloscopes

071-7000-02
To Use the Front Panel

You can use the dedicated front-panel knobs and buttons to do the most commonly performed operations.

- Turn **INTENSITY** to adjust waveform intensity.
- Push **FastAcq** to turn Fast Acquisition on and off (CSA7000 and TDS7000 Series only).
- Push **CURSORS** to turn cursors on and off.
- Push **PRINT** to make a hard copy.
- Push **DEFAULT SETUP** to return settings to the default values.
- Push **AUTOSET** to quickly set the vertical, horizontal, and trigger controls for a usable display.

Use the multipurpose knobs to control parameters selected from the screen interface.
- Push a **FINE** button to make small changes with a multipurpose knob.
- Push **ZOOM** to add a magnified graticule to the display. Push the **HORIZ** or **VERT** button to select the axis that you want to magnify.

Use these knobs and buttons to set horizontal **SCALE** and **POSITION** for the waveforms. Push **DELAY** to turn on horizontal delay, and then use **POSITION** to set the delay time. Adjust **RESOLUTION** to change the number of acquired points in the waveform.

Use these knobs and buttons to set the basic trigger parameters. Push **ADVANCED** to display a menu of additional trigger functions.

Use these buttons to start and stop acquisition or start a single acquisition sequence. The ARM, READY, and TRIG'D lights show the acquisition status.

Turn channel displays on and off, and adjust the channel **POSITION** and **SCALE** using dedicated knobs and buttons.
To Use the Screen Interface

You can control all oscilloscope functions except the power switch using only the screen interface.

Choose the Toolbar

- Touch a button in the toolbar to display a control window at the bottom of the display.
- Touch a screen control to change a setting.
- Touch a numerical control to assign that control to a multipurpose knob. Turn the multipurpose knob to adjust the parameter value.

Choose the Menu Bar

- Use some menu items to display a control window at the bottom or side of the display.
- Use some menu items to directly change settings.
- Touch here to close a control window.

More Operating Tips:

- Use the touch screen to control the oscilloscope when bench space is unavailable, such as on a cart or in an equipment rack.
- Plug in a mouse and keyboard if you have the bench space to use them. You can plug in a USB mouse or keyboard anytime, even while the oscilloscope is running.
- Use the menu bar to access PC-related functions, such as Page Setup, Export, and Copy.
To Display a Waveform

1. Attach a probe to CH 1 and connect the probe to your signal.

2. Push CH 1 if channel 1 is not already displayed.

3. Push AUTOSET.

4. Adjust VERTICAL and HORIZONTAL POSITION and SCALE if necessary to optimize the display.

5. Adjust RESOLUTION to change the record length and sample rate. You can acquire more samples in the waveform to see more detail or acquire fewer samples with a faster update rate.

6. Adjust INTENSITY to change the brightness, vector fill, and display persistence of acquired points.
To See More Waveform Detail

Use Zoom

Push the ZOOM button to display a zoom graticule.

Push the HORIZ button or the VERT button to select the axis to magnify in the zoom graticule. Use the multipurpose knobs to adjust the position and magnification factor of the zoomed waveform.

You can also set up a zoom graticule from the screen interface. First touch and drag across the segment of the waveform that you want to see in greater detail.

Then select a zoom mode from the drop-down list to magnify the highlighted waveform segment.

Use Horizontal Delay

Use horizontal DELAY to acquire waveform detail in a region that is separated from the trigger location by a significant interval of time.

Push the front-panel DELAY button.

Adjust the delay time with the horizontal POSITION control, or enter the delay time in the control window.

Adjust the horizontal SCALE to acquire the detail you need around the delay expansion point.

More Operating Tips:

- You can use Zoom and Horizontal Delay together to magnify a delayed acquisition.
- Toggle Horizontal Delay on and off to quickly compare signal details at two different areas of interest, one near the trigger location and the other centered at the delay time.
To Use Fast Acquisition (CSA7000 and TDS7000 Series only)

Turn Fast Acquisition on to acquire up to 400,000 waveforms per second.

1. Push the front-panel FastAcq button. Or select Fast Acquisitions in the Horiz/Acq menu.

2. Adjust INTENSITY to optimize the intensity or color grading for the signal being analyzed. Increasing intensity can make less-frequently acquired points brighter in the display.

How DPOs Work

Digital Phosphor Oscilloscopes (DPOs) continuously acquire waveforms at rates comparable to analog oscilloscopes. In Fast Acquisition mode, DPOs continuously overlay the acquired information into a three-dimensional database that is updated on the display 30 times per second. For each pixel in the display, the intensity (or color) of the pixel is proportional to the number of actual samples that the pixel represents.

More Operating Tips:

- Choose one of the color grading palettes in the Display Colors control window to see different sample densities represented in different colors.
- Turn AutoBright on in the Display Appearance control window. When you use AutoBright, the displayed waveforms remain visible even at low trigger repetition rates.
For Average or Envelope acquisition modes, touch the \# of Wfms control and then set the number of waveforms with the multipurpose knob. You can also double-touch the control and use the pop-up keypad.

To Choose an Acquisition Mode

1. Select Horizontal/Acquisition Setup... in the Horiz/Acq menu or touch the Horiz button; then open the Acquisition tab.

2. Select an acquisition mode in the horizontal/acquisition control window.

How the Acquisition Modes Work

Sample mode retains one sampled point from each acquisition interval.

Waveform Data Base mode takes an ensemble of acquisitions that is best for accurate eye pattern measurements.

Peak Detect mode uses the highest and lowest of all the samples contained in two consecutive acquisition intervals.

Hi Res mode calculates the average of all the samples for each acquisition interval.

Envelope mode finds highest and lowest record points over many acquisitions. Envelope uses Peak Detect for each individual acquisition.

Average mode calculates the average value for each record point over many acquisitions. Average uses Sample mode for each individual acquisition.

acquisition interval = \[ \frac{\text{record duration}}{\text{number of points in record}} \]
To Select a Trigger

Select the EDGE trigger type and then set the source, coupling, slope and mode with these front-panel controls. Push ADVANCED to select one of the other trigger types.

You can also select a trigger type in the Trig menu.

Or touch the Trig button and then select a trigger type in the trigger control window that is displayed.

### Trigger Selections

<table>
<thead>
<tr>
<th>Trigger type</th>
<th>Levels</th>
<th>Timers</th>
<th>Trigger conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge</td>
<td>Single level</td>
<td>None</td>
<td>Trigger on rising or falling edge, as defined by slope control. Coupling choices are DC, AC, AC LF Reject, AC HF Reject, and Noise Reject.</td>
</tr>
<tr>
<td>Comm</td>
<td>Depends on Coding</td>
<td>None</td>
<td>Trigger on telecom signals. Optional on TDS7000 series.</td>
</tr>
<tr>
<td>Serial</td>
<td>Single level plus clock and bit pattern</td>
<td>None</td>
<td>Trigger on serial pattern data. Optional on TDS7000 series (not available on TDS7104 or TDS7054).</td>
</tr>
<tr>
<td>Glitch</td>
<td>Single level</td>
<td>One to specify glitch width</td>
<td>Trigger on glitches narrower than the specified width or ignore glitches narrower than the specified width.</td>
</tr>
<tr>
<td>Width</td>
<td>Single level</td>
<td>Two to specify minimum and maximum pulse widths</td>
<td>Trigger on pulses that have widths between the range of the two timers or outside the range of the two timers.</td>
</tr>
<tr>
<td>Runt</td>
<td>Two levels to define the logic transition region</td>
<td>One to specify an optional minimum runt-pulse duration</td>
<td>Trigger on a pulse that enters the transition region from one side but does not leave the region from the other side.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Single level</td>
<td>One to specify time-out time</td>
<td>Trigger when a signal does not make a transition for a specified length of time.</td>
</tr>
<tr>
<td>Transition</td>
<td>Two levels to define the logic transition region</td>
<td>One to specify transition time</td>
<td>Trigger when a logic signal spends more time or less time in the transition region than a specified amount of time.</td>
</tr>
<tr>
<td>Setup/Hold</td>
<td>Independent levels for Data and Clock</td>
<td>One to specify setup time and one to specify hold time</td>
<td>Trigger on violations of setup or hold time between a Data signal and a Clock signal. The specified setup and hold times can be positive or negative values.</td>
</tr>
<tr>
<td>Pattern</td>
<td>Independent levels for each channel</td>
<td>One to specify pattern duration</td>
<td>Trigger when a Boolean combination of up to four channels becomes true. Trigger immediately or only after the combination is true for a specified time duration.</td>
</tr>
<tr>
<td>State</td>
<td>Independent levels for each channel</td>
<td>None</td>
<td>Trigger on transition of one channel when a Boolean combination of up to three other channels is true.</td>
</tr>
</tbody>
</table>
To Use the A (Main) and B (Delayed) Triggers

You can use the A Event (Main) trigger alone or combine it with the B Event (Delayed) trigger to capture more complex signals.

1. Set the A trigger type and source in the A Event (Main) tab of the trigger control window.
2. Choose a function in the A→B Sequence tab of the trigger control window.
3. Set the trigger delay time or the number of B events, as appropriate.
4. Set the B trigger characteristics in the B Event (Delayed) tab of the trigger control window.

Trigger on B Event

The A trigger arms the oscilloscope. Posttrigger acquisition starts on nth B event.

B Trigger After Delay Time

The A trigger arms the oscilloscope. Posttrigger acquisition starts on the first B edge after the trigger delay time.

More Operating Tips:

- B-trigger delay time and horizontal delay time are independent functions. When you establish a trigger condition using either the A trigger alone or the A and B triggers together, you can also use horizontal delay to delay the acquisition by an additional amount.
- When using the B trigger, the A trigger can be any of the following types: Edge, Glitch, Width, or Timeout. The B trigger type is always Edge type.
To Perform Mask Testing
(CSA7000, optional on TDS6000 and TDS7000 Series)

Select **Mask Setup** in the **Masks** menu.

Choose a mask type.

Choose a mask standard.

Select **Autoset** to automatically set up the controls based on the input signal.

Optionally select **Autofit** to align each acquired signal with the mask to minimize the number of hits.

Use the **Source** tab to select the source of your signal.

Use the **Tolerance** tab to increase or decrease the mask margin used in mask testing.
To Set Up Mask Pass/Fail Testing and View Results
(CSA7000, optional on TDS6000 and TDS7000 series)

1. Use the Pass/Fail Setup tab to set up Pass/Fail testing.

2. Use the Pass/Fail controls to start, stop, or continuously run a mask test.

3. Use the Polarity controls to select testing the positive, negative, or both the positive and negative pulses.

4. Enter the number of waveforms to acquire and use in your mask test.

5. Enter the number of waveforms that must fail to consider the test a failure.

6. Enter the time that the instrument delays before starting the mask test.

When using masks that enable the Waveform Database mode, the # of Wfms field changes to # of Samples field.

Use the Pass/Fail Test Notification controls to select how you want to be notified when a failure occurs and when the mask test completes.

Use the Pass/Fail Results tab to view the results of your mask testing.
To Take Automated Measurements

Touch the Meas button, and then select up to eight measurements using the measurement control window.

Use the tabs to choose measurements in the various categories.

Or choose a measurement for the selected waveform directly in the Measure menu.

Automated Measurement Selections

<table>
<thead>
<tr>
<th>Amplitude</th>
<th>Time</th>
<th>More</th>
<th>Histogram</th>
<th>Comm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplitude</td>
<td>Max</td>
<td>Rise Time</td>
<td>Area</td>
<td>ExtRatio, Eye Height, Eye Top</td>
</tr>
<tr>
<td>High</td>
<td>Min</td>
<td>Fall Time</td>
<td>Cycle Area</td>
<td>Ext Ratio %, Eye Width, Eye Base</td>
</tr>
<tr>
<td>Low</td>
<td>Pk-Pk</td>
<td>Positive Duty Cycle</td>
<td>Phase</td>
<td>Ext Ratio (dB), Crossing %</td>
</tr>
<tr>
<td>RMS</td>
<td>Cycle RMS</td>
<td>Period</td>
<td>Burst Width</td>
<td>Jitter P-P, Noise P-P, Cyc Distortion</td>
</tr>
<tr>
<td>Positive Overshoot</td>
<td>Mean</td>
<td>Frequency</td>
<td>Std Deviation</td>
<td>Jitter RMS, Noise RMS, Q-Factor</td>
</tr>
<tr>
<td>Negative Overshoot</td>
<td>Cycle Mean</td>
<td>Delay</td>
<td>Jitter 6σ</td>
<td>S/N Ratio</td>
</tr>
</tbody>
</table>
To Customize an Automated Measurement

Use Gating to confine the measurement to a certain portion of the waveform.

Turn on measurement statistics to characterize the stability of the measurement.

Adjust the measurement reference levels to different relative or different fixed values.

Select snapshot to see a one-time view of all valid Normal or Comm measurements.

To Set Up a Histogram

Touch and drag across the segment of the waveform that you want the histogram to cover. To set up a horizontal histogram, for example, make the box wider than it is tall.

Select Histogram Horizontal from the drop-down list.

View the histogram at the top or edge of the graticule.

If you need to make any adjustments to the histogram, use the histogram setup control window. Select Waveform Histograms in the Measure menu.

Take automated measurements on histogram data. See previous page for information.
To Take Measurements With Cursors

1. Push the front-panel CURSORS button.

2. Select the waveform you want to measure and a cursor type in the cursor control window. Or you can activate cursors on the selected waveform directly in the Cursor menu.

3. Push Setup and place cursors with the multipurpose knobs or enter the cursor locations numerically.

4. If you choose Waveform cursors to take measurements between waveforms, select the source for each cursor.

5. Read cursor measurement results in the display.

Other Cursor Measurement Tips:

- You can set the cursors to move together in tandem if you choose the Tracking cursor mode. The cursors move independently if you choose the Independent cursor mode.

- If you use the zoom graticule, you can place a cursor directly on a specific waveform point to take precision measurements.

- You can also move cursors by touching or clicking them and then dragging them to a new position.
To Use Math Waveforms

Select **Math Setup** in the **Math** menu.

Choose one of the predefined math equations.

Or touch **Editor** to define a more advanced math waveform. Then build the waveform expression using sources, operators, constants, measurements, and functions.

To Use Spectral Analysis

In the Math menu, select **Spectral Controls** to define FFT magnitude and phase waveforms. When an FFT waveform is selected, you can use the multipurpose knobs to adjust the FFT waveform just as you would using a spectrum analyzer.

You can view time-domain and frequency-domain waveforms simultaneously. You can also use gating to select only a portion of the time-domain waveform for spectral analysis.
To Store Information

To Save and Recall Waveforms

To save or recall waveforms, select Reference Waveforms and then Save Wfm... or Recall Wfm... in the File menu.

Or touch the Refs button.

Use the reference setup control window to copy a live waveform into one of four nonvolatile reference waveform storage locations. You can also display these waveforms as reference waveforms.

Select Save Wfm to File to store the live waveform as a file on a disk drive. You can recall a waveform stored on disk into one of the internal reference waveform locations for display.

To Save and Recall Instrument Setups

To save an instrument setup, select Instrument Setup in the File menu.

Or touch the Setups button.

Use the settings control window to save the current setup into one of ten internal storage locations. Use the pop-up keyboard to label the setups for easy identification.

Or select Save Settings to File to store the current setup on a disk drive. You can recall any setup stored on disk and then save it in an internal setup storage location for quicker access.

To restore the oscilloscope to a known initial state, push the front-panel DEFAULT SETUP button.

Or select Recall Default Setup in the File menu.
To Print a Hard Copy

To print a hard copy to an attached printer or a network printer, push the front-panel PRINT button.

Or select Print in the File menu. If necessary, you can make changes to the page orientation in the Page Setup dialog box.

The Page Setup dialog box also includes selectors for the print palette and a feature called Ink Saver. Ink Saver optimizes the display colors and shades for printing hard copies on white paper.

To Copy or Export Your Results

You can use the Windows clipboard to copy information. Simply select the item to copy, copy it, and then paste it into another Windows application.

You can export waveform data into a comma-separated ASCII file for use in a spreadsheet or data analysis program. Select Export Setup in the File menu to set the output content and format for images, waveforms, or measurements.
To Run Application Software

You can install and run optional application software on your oscilloscope. These software packages provide advanced capability supporting many applications. Two examples are shown below; additional packages may be available. Contact your Tektronix representative for more information.

Use TDSJIT Jitter Analysis Software to characterize timing performance. Analyze jitter on contiguous clock cycles using single-shot acquisitions.

Use TDSDDM Disk Drive Measurement Software to measure disk drive signals according to IDEMA standards.

Follow the instructions provided with the application software to install it. To run the software, select the application in the File / Run Application menu.
To Connect to a Network

Like any other Microsoft Windows-based computer, you can connect the oscilloscope to a network to enable printing, file sharing, internet access, and other communications functions.

To make a network connection, consult with your network administrator, and then use the standard Windows utilities to configure the oscilloscope for compatibility with your network.

To Use a Dual Monitor

Connect a keyboard, mouse, and monitor to the oscilloscope and configure Windows for dual-monitor mode. You can operate the oscilloscope while having full use of Windows and other installed applications on the external monitor.

Connect the monitor to the upper SVGA port on the oscilloscope rear panel. Use the Settings tab in the Windows Display Properties dialog box to set up a dual-monitor configuration.
To Access the Help System

Touch the HELP button or select Help on Window in the Help menu to receive context-sensitive help on the current setup.

Select Contents and Index in the Help menu to access any topic in the help system. Select the topic, and then touch the Display button in the dialog box.

Touch an outlined control shown in the help window to receive more specific information about the control.

Touch a tab in a help window to navigate between the Overview and specific topics.

Touch the Minimize button in a help window to move help out of the way so you can operate the oscilloscope. Touch the Restore Help button to see the last help topic again.
Front Panel Inputs and Outputs

CSA7404
CSA7154

Floppy disk drive accessible from Windows
Ground terminal
Channel inputs
Probe compensator output to compensate and deskew probes
Recovered clock output
Recovered data output
Optical input to O/E converter
Electrical output from O/E converter

TDS6404
TDS6604
TDS7404
TDS7254
TDS7154

Floppy disk drive accessible from Windows
Ground terminal
Channel inputs
Probe compensator output to compensate and deskew probes
Auxiliary input to provide an external trigger input
Auxiliary output to provide trigger output signal
Analog signal output from the CH 3 input

TDS7104
TDS7054

Floppy disk drive accessible from Windows
Ground terminal
Channel inputs
Probe compensator output to compensate and deskew probes
Auxiliary input to provide an external trigger input
Auxiliary output provides trigger output signal
Analog signal output from the CH 3 input
Rear Panel Inputs and Outputs

- Removable hard disk drive to provide individual environment for each user or to secure data; press cover to release the disk
- CD-RW drive accessible from Windows; press cover to open the drive
- USB connector for mouse, keyboard, or other peripherals
- PS-2 connector for mouse
- PS-2 connector for keyboard
- Upper SVGA port to connect a monitor for dual-monitor operation
- Lower VGA port to replicate the oscilloscope display on an external monitor
- Parallel port (Centronics) to connect printer or other device
- GPIB port to connect to controller
- RJ-45 connector to connect to network
- COM1 serial port
- Connectors for speaker and microphone
- CSA7000 only: Auxiliary (external trigger) input, Auxiliary (trigger) output signal, Analog (CH3) signal output
- External reference input and internal reference output
Recommended Probes and Accessories

CSA7404, CSA7154, TDS7404, TDS7254, TDS7154, TDS6000 Series

- P7240 4 GHz Active Probe for general-purpose applications
- TCA-SMA, TCA-BNC 50Ω, and TCA-N adapters for your probes and cables
- P7330 Differential Probe for differential-signal and low-noise applications
- P7260 6 GHz 5x/25x Active Probe
- CSA7000 only. O/E-to-TekConnect and O/E-to-SMA adapters for O/E converter
- TCA-SMA, TCA-BNC 50Ω, and TCA-N adapters for your probes and cables
- TCA-1MEG Buffer Amplifier to connect 1 MΩ accessories

TDS7104, TDS7054

- P6139A Passive Probes for general-purpose applications
- P6247 and P6248 Differential Probes for differential signals and low-noise applications
- TCP202 Current Probe for general-purpose applications
- P6243 and P6245 Active Probes or P6158 Low-C Probe for high-speed applications